
Gatornet: E-mail and campus bulletin boards
Software such as First Class by SoftArc (Centrinity) allows use of your network to facilitate e-
mail and campus bulletin boards. Gatornet began on 9/1/03 and the progress has been amazing.  
The software supports modem access from home for Macs or PCs. Numerous academic projects 
have emerged in all subject areas: computers, history, spanish, latin and so on. Numerous 
conferences by “special interest groups” were created, and students/faculty writing to each other 
or chatting with each other has become a mainstream part of the culture of the school. We issue 
new accounts to the 200 new students who are accepted each March and allow matriculating 
students to keep their accounts for the six months before they have formally stepped foot on 
campus. Numerous students and faculty members have been amazed by the range of unique and 
interesting dialogs that regularly take place between students and faculty 
members. Of course, we have had to insist on netiquette rules and 
crashes can send the school into fits, but Gatornet in all its 
configurations has transformed the entire community.

-- Steve Bergen (bergen@chapin.edu) www.summercore.com --

Gatornet: an overview
Question 1: What are the steps when logging on?
When asked for your User ID and Password, use TAB to jump from one box to another; don't 
push return until both are correct; uppercase vs lowercase is not relevant.

Question 2: How to change my password?
Once you have logged in, look under the Service Menu. Type your own password, then type 
your own new password again. It is against GatorNet Rules to let someone else use your account 
or for you to use someone else’s account. In the adult world, this is called fraud. Please keep 
your password to yourself and change it occasionally. Do not make your password ONE byte 
long!

Question 3: How do I log on from home? 
Download the software from www.centrinity.com; we can be accessed via TCP using 
gatornet.chapin.edu as the equivalent for the IP address.

Question 4: How do the time limits work at home or at school? 
Initially, students have 60 minutes per day, upgraded to 144 minutes upon familiarity of the 
important rules posted on the actual Wittenberg Door. Sending an appropriate note to the 
electronic conference called the Wittenberg Door changes the temporary status of that student to 
be an Fairfax License with 144 minutes per day and more privileges. Students who help out in the 
computer lab get 288 minutes per day while students on the Computer Department Student Staff 
get unlimited time (as do faculty members). 

Question 5: What are the basics of Internet access? 
Everyone can receive Internet mail by using his/her name followed by chapin.edu with an 
underscore in between, For example Steve_Bergen@chapin.edu. In order to get Internet access, 
students must complete the Internet Access form, together with parent and advisor signature.
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Question 6: How to send mail to a conference?
To send to a person or a conference, just type a few bytes of the name in the TO box and the 
computer will find all the people or conferences that include those bytes. For example, if there is 
a conference names Celtics Stink or Celtics Conference or Celtics without Pitino, all you need to 
do is to type Celtics in the TO line, and push TAB. The software is clever enough to identify 
any conference with a “first name” of Celtics. Sending mail to a conference is not harder than 
sending mail to an individual. As far as the computer goes, a conference named Celtics Stink is the 
same as a person named Steve Bergen; Celtics is the first name and Stink is the last name. 

Question 7: How to find a conference?
Finding a specific conference can be challenging. The conference might be located in the Public 
Conference section, under Academic or General. Or it might be a private conference in the faculty 
private area or parent private area or trustee private area. Using the student or faculty “FIND” 
directory can be helpful in locating the conference. 

Question 8: How to make an alias of a conference?
Instead of alias, First Class prefers to think of this as adding a shortcut to your desktop. Select 
the conference or folder and then click and hold (on a Mac) or right-mouse click (on a PC) 
choosing the feature called add to desktop. Voila! You will now have an alias (i.e. shortcut) to 
that conference on your personal GatorNet desktop. 

Question 9: How do I download files from GatorNet to my own computer?
The key involves attached files. For example in the conference called Public Domain, you will 
find several messages posted that contain attachments. If you double-click (or click and hold) on 
that attachment, the computer asks you where you want to save the file. If you are not careful, it 
will save it within the folder called downloads. Be careful to navigate to a specific folder. You can 
also drag and drop the attached file onto your desktop or into a specific folder. 

Question 10: How do I upload files?
The opposite skill is called uploading, a privilege given to faculty, parents, trustees and N license 
students. Try sending a message to another user and then choose the feature called Attach file 
under the File menu. You will have to navigate to the file on your floppy or hard drive that you 
want to send. Once you select it, the file is transferred to the GatorNet server and is 
automatically attached to your message. when another user reads your message, he/she can now 
download it. you might say that uploading is like depositing money in a bank and downloading is 
like withdrawing it. Please be honest with your uploads and downloads. We do not want any 
applications uploaded or downloaded, even public domain or shareware. You can also attach a file 
or files from your hard drive by selecting (or shift-selecting multiple files) and then dragging and 
dropping the files onto the top part of the Gatornet message (the address section.) The Drag and 
drop method is terrific because you can drag more than one file at a time.

Question 11: What should I do if I get Internet mail that looks like a chain letter with or 
without inappropriate language?
We would like you to delete the mail right away. Even if it makes you laugh, please do not send it 
on. We consider this to be a violation of GatorNet rules, since forwarding inappropriate mail 
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means that you have taken some ownership of it. We cannot prevent Internet mail from coming 
to your account, but we want you to delete the letter and not send it on.

Question 12: What do the different flags mean? 
The Yellow Flag means a message from you that has not yet been sent, while Red Flag means a 
message that has not been read by you yet. If you have sent a message, but the recipient(s) has 
not read it it, you can choose unsend under the Message Menu. On some Macs and PCs, the 
flags are not red and yellow, but rather “filled in” or “empty.”

Question 13: How do resumes work? 
By double clicking on your own name in the directory you gain access to your resume. There you 
can type in (or copy and paste in) your daily or monthly schedule or other personal info about 
you. Then others can view this info by double-clicking on your name. When you are sending a 
note to someone, just double click on their name to see the contents of their resume, which can be 
text and/or graphic. We decided that there are to be no graphics in resumes because of congestion 
on GatorNet. We have evolved a system of turning off the resume feature for students if there 
exists any graphic or language that is not part of the informational template. To avoid problems, 
we have said “no personal philosophy or quotes, no philosophy, no quotes, just information.” 
The Student Staff has taken charge of turning off the resume of students violating these rules.

Question 14: How does chatting on-line work?
Under the Conferencing Menu, you can check Who's On Line. Then File Menu, choose Open, 
then Private Chat and invite someone to talk with you. Others can be invited to chat, so it is 
possible to have a Chat Room with 5-10 people in it.

Question 15: What are the basic etiquette rules, something we call Chapin Netiquette? 
First of all, do not invite anyone to chat repeatedly. Secondly, do not let anyone else use your 
account, and do not use anyone else’s account. Thirdly, watch your language on GatorNet. 
Electronic graffiti is no different from regular graffiti. 

Question 16: Is it is possible to see graphics or hear sounds via GatorNet? 
First Class allows graphics to be copied and pasted into the body of the message. Sounds can be 
sent as attached files and/or can be recorded when sending a new message. You can also drag and 
drop an image from the Web or from a file onto the body of the message section.

Question 17: How do I change the expire date of a file so that it does not disappear after 
the set number of days?
To alter the expire date, click once on the file and choose Get Info under the File menu (Mac) or 
Preferences under the Edit menu (PC). You can change the expire date to be one month, one year 
or never. Shortcut includes “click and hold” on Mac or “right-mouse click” on PC.

Question 18: How do I configure my account so that my replies go only to the sender?
Under Edit Menu, choose Preferences and then the Mailbox tab; change your Reply preference to 
Reply sender. This avoids the problem of replying to a message sent to you as part of a mailing 
list, only to find out that your personal response has gone out to hundreds of people!
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Question 19: What are the rules for mailing lists?
Mailing lists (ML) generally are reserved for student staff & faculty usage. Otherwise, the spam 
would be incredible! A mailing list is a huge cluster of people. The ease of constructing and using 
mailing lists has been key to the popularity and success of GatorNet! We have mailing lists to 
parents, students, academic departments, trustees.

Question 21: How do I Make a New Folder and give it an Icon?
Under File, choose New Folder. Now click on the folder and choose Get Info under File (Mac) or 
Properties under File (PC); you can rename the folder and double-click one of the many icons.

Question 22: How do I set up my mailbox so that I can create folders above the line?
Under the View Menu, choose Split, then either Horizontal or Vertical. To move selected items 
into a folder, use the Shift-click trick; to move all your mail into a folder, use Select all under Edit. 
Note that files in folder will still expire on the designated date.

Question 23: How do I Delete Mail in my Mailbox?
Click on the item, then choose Delete under File. To delete a number of documents: click on one, 
hold down Shift and click on others; use Command-click (Mac) or control-click (PC) for files that 
are non-contiguous. The Shortcut is Command-D on the Mac and Control-D on the PC.

Question 24: How do I Inspect or Change the Expire Date of anc item in my mailbox?
Click on the item, then on the Mac choose Get info under File; now check the Expire arrow and 
see what it is set for. On the PC, right-mouse click on the message, then choose Properties, then 
change the Expiration period.

Question 25: How do I view my mail in an organized fashion?
Click the heading at the top of each column to sort by that category in forward or reverse order, 
depending on your mouseclick. However the sort order will be quirky unless you have adjusted 
things via Change view properties under View; change Group items to be None.

Question 26: How do I make a message change from red-flag to not-red-flag or visa versa?
Hold down Option on the Mac or Control on the PC and click on that file; this is the same as the 
Message menu choice of Unread. This is a very useful trick for reminders! Even better, by 
choosing Get Info or Properties, you can change the name of the note to say something like ---> 
CALL THIS PERSON ASAP.

Question 27: How do I open a number of documents at once
Click on one, hold down Shift and click on others; then choose Open under File.

Question 28 : How do I make a new document as a Reminder list or Journal entry for 
myself, not to send to anyone else?
Choose New document under the Message menu; this is a great tip that not enough users 
understand. This feature lets you make a document that you can come back to and edit 
frequently. The expire date on this document is automatically Never.
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Question 29: What are 3 of the most useful keyboard commands?
Make a new document or message: command-N on Mac or control-N on PC.
Close the specific document and choose to send at same time: command-W on Mac or control-W 
on PC. Send the specific message that you are writing: command-E on Mac or control-E on PC.

Question 30: How do you create a quoted reply?
Highlight the portion of the message from someone to you, then choose Reply under the Edit 
menu. Alternatively, if you want the entire document quoted, choose reply with quote.

Question 31: How do I search for a lost note?
Assuming your note is within a conference or your own mailbox, the Find feature under Edit is 
very powerful, finding notes that contain key words in their title or even within the text.

Question 32: Any way to get a receipt when someone reads the note?
Yes, a wonderful feature is that you can tag a note (before you actually send it) with the feature 
under Message called Receipt on Read. As soon as the recipient reads your note, you get a 
message in your mailbox telling you the exact time. This is an alternative to viewing history.

Question 33: Any way for an important note to be given a higher priority?
Yes, before sending the note, tag it with the feature under Message called Priority urgent. The 
note stays in bold at the top of the recipient’s mailbox; it can’t force him/her to read it, however!

Question 34: Any way to spell-check in English or other languages?
Yes, there is a feature under Edit called Check spelling. Additionally, you can configure your 
dictionary to be Spanish, French or several other languages. All of these dictionaries are free from 
Centrinity (formerly SoftArc) the company that makes First Class.

Question 35: How does View history work?
By choosing the History under the Message menu of any note, you see the exact details of who 
has read the note and at what time. This can be a scary and sobering feature! 

Question 36: How does BCC (blind carbon copy) work?
Any names or mailing lists put into BCC (choose SHOW BCC under MESSAGE) do not see 
that others have received this note. For example, if you put 5 students into the BCC stating that 
they have failed the recent test, they do not see the other 4 students who received the note. More 
importantly, putting internet names (e.g. parent mailing list) into the BCC avoids the hassle of 
each recipient getting a long list of all the other e-mail addresses!

Question 37: How does the Unsend feature work?
With a few exceptions, notes that have been sent can be taken back (feature called Unsend is 
found under the Message menu). If the recipients have read the note, then Unsend does nothing 
to their mailboxes. But it removes the note instantly from the mailboxes of all those who have not 
read the note. 
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Question 38: What about the New form feature?
GatorNet comes with various forms other than standard e-mail notes. In addition, we have built 
several of our own, including T license request and Internet Access Advisor approval. As long as 
you have the standard GatorNet settings file (not available from Centrinity), then you get to see 
these special forms, sometimes called New Message Special.

Question 39: What are some of the more esoteric command keys that I can use?
Here are the keys for color on the Mac (not PC) after highlighting text: command and option and 
b to get blue, r to get red, y to get yellow, g to get green, m to get magenta and k to get black.

Question 40: How do the Address Book feature and Personal Mail List work?
The Address Book is a great feature given to all faculty, parents, trustees, visitors as well as 
students with Internet Access; the address book lets you have a code word for a group of people 
or a code word for an Internet Address. The Address Book is different from the institutional 
Mailing Lists made by the computer department and reserved for faculty members. 
• Under the File Menu, choose New, then choose New Personal Address or New Personal Mail 
List. In the Name section, enter a recognizable and easy to use code word. Next enter the e-mail 
address in the e-mail section. Close box and press Save. Alternately, when you get a message 
from someone and you want that e-mail address entered into your address book, simply Right-
mouse click (PC) on the address or Control-click or “click and hold” (Mac), choosing Add to 
address book. Each address book item can contain other info including phone and text.
• To Use your Address Book, go to your mailbox and try writing a note to someone. Type a few 
characters of the code word and push Tab; the computer will now make this show up at the To 
location and you will have saved yourself the trouble of remembering those Internet Addresses. 
Although an Address Book item can be used for a few names, it is best to use a Personal Mailing 
List for tasks like writing one note to multiple advisees or students, since you can put many 
items into each Personal Mailing List CODE WORD. 
• You can see a list of your address book items and/or change them via FILE then OPEN and 
choosing Address Book.

Question 41: How do I disable call-waiting from my home phone?
If your phone at home has call waiting, put *70, in front of the phone number in the Setup of 
GatorNet e.g. *70,781-320-1314. You can enter 1170 before the phone number as well!

Question 42: How do I use different fonts to line up columns, since tabs are problematic?
If you use a mono-spaced font, such as Courier, Monaco, Courier New , you can then line up 
columns via SPACES. 

Question 43: How do I subscribe to a listserv?
A Listserv is an electronic magazine that you subscribe to; it comes to your individual e-mail box. 
Sometimes we take the Listserv folder and give it an alias, putting it in a public location for others 
to see; this is a GatorNet trick, but in general a Listserv is an electronic newsletter that you 
subscribe to as an individual. 
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Question 44: What about newsgroups?
A newsgroup is a public conference/bulletin board around the world. There are thousands of 
newsgroups. We choose to subscribe to some of them and the data flows into GatorNet. In 
contrast to a Listserv which goes to individual e-mailboxes around the world, a Newsgroup is a 
bulletin board.

Question 45: How do I avoid the carbon copy blues?
When you choose to Reply to a note from someone sent via a mailing list, it goes to everyone on 
that mailing list unless you make sure the cc is blank. CC stands for carbon copy. 

We've got those carbon copy 
... too much junk mail -blues

All we've got is our own good time to lose.
Either you must blank out the cc each time or remember to set your preferences to Reply Sender.

Question 46: How do I use my résumé and how do I look at others?
To view the resume of someone else, you just double-click on that user's name in any TO box or 
CC box. Or you can choose directory, find the person, double-click there. There are a million 
roads to Rome and a million ways to view each others' resume! You cannot change someone else's 
resume, only view it. Students without Fairfax license privileges cannot access others’ resumes.

Question 47: Is true that GatorNet links to the web addresses automatically?
Web links automatically load up your web browser (if connected) to the web.

Question 48: How do you select multiple messages?
 On the Mac try holding down the command button (has the open-apple on it) and then clicking. 
On the PC, hold down the Control button and then click. Use shift-click when you want to 
highlight the first and last of a bunch of messages in a row.

Question 49: How do you change the default background of all your messages?
Click on the Appearances tab; 3D look must be on. Click on Editor Background (that is First 
Class' name for the place where you write messages.) Click and hold on the down arrow next to 
the box marked Image: that is next to Editor Background checkbox. The box will probably say 
Default; then choose the design you want. Click Apply to test it and then OK when you are 
content. Now all your messages will have this background.

Question 50: How to chat on-line?
Under file go to open and go down to private chat. Multiple people can be in a chat room at once.

Question 51: What is special about the UNDO feature?
You can UNDO multiple levels, in effect going back several moves in your editing!

Question 52: Will GatorNet allow you a signature at the bottom of certain notes?
Yes, look under Preferences under Edit and you will see a Tab that says Signature. You put your 
info in here and then just mouse-click on the icon when you want the optional text.
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Question 53: Can GatorNet select all messages from one person with one click?
Yes, to quickly select all messages from the same person, or about the same subject, or with the 
same date, Control-Shift-click (PC) or Command-Shift-click (Mac) one occurrence of the name, 
subject, or date. 

Question 54: Can GatorNet preserve the formatting of text from WP documents?
FirstClass version can accept basic formatted text copied from any WP program. Students may, 
therefore, submit any written assignments to their teachers as e-mail messages with all special 
formatting (titles, italic, bold, font size, paragraph styles, etc.) preserved. The teacher may then 
annotate a student's work (in a different font, color, or style) and return the assignment to the 
student again as an e-mail. Students may also exchange their writing in a group editing project; 
many other uses come to mind. 

Question 55: Can GatorNet let you show deleted messages?
Yes, but only from the time of the last trash collection which is generally 2AM of previous night 
To undelete a message, go to the View menu and choose Show Deleted Items. To read a deleted 
message, select it, go to the File menu and choose Undelete. To hide deleted messages again, go 
back to View and choose Hide Deleted Messages.

Question 56: Can GatorNet summarize multiple e-mail notes into one document?
You can select as many different e-mails (contiguous with Shift or non-contiguous with 
Command/Control) that you want and then go to the Conferencing menu and choose Summarize 
Selected Messages. Gatornet will take the contents of all of those e-mails and put them into one 
neat and tidy text document (no more copying and pasting) complete with exact dates and times. 
Once you have this summarized document, don’t forget to Copy and Paste it into a new note. 
This trick also makes it easier for you to save and then Delete more e-mails. 

Managing Tricks & Tech Tips for First Class
(compiled, created and written by Steve Bergen over the years from 1994 on)

Adding Identifier to Suffix (e.g. Year of Graduation) to the Last Name
At Chapin, the last name of a faculty member has a suffix of -fac, the last name of a visitor has a 
suffix of -vis, the last name of a parent has a suffix of -par, the last name of a trustee has a suffix 
of -tr and each student has a suffix of -02 or -039 or -04 based on year of graduation. At first, we 
did this with a separating space and found out that this messed up the “reply” feature of many 
internet outsiders. We then eliminated the space, changing for example the Bergen (fac) to be 
Bergen-fac. We have found this to be a very useful system, helping to identify “who’s who” 
easily and quickly when getting e-mail and being in chat rooms.

Assignment Turn-in via Conferences
At Chapin, students in numerous classes are told to turn in assignments by sending the GatorNet 
note to the CP1 Noteboard, the Spanish IV Conf perhaps with a cc to the specific teacher. The 
advantage of this system is that the conference holds the e-mail for a longer period of time and is 
more easily organized.
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Auto-Open Note in Auto-Open News
It took me a lot longer than it should have to learn how to do this: make a document within auto-
open news, then choose GET INFO to make the document be protected and auto-open, then 
close up and save the document and tag it as “unread” before quitting.

Avoiding any use of master admin at school due to KeyStroke Recorders
At past schools, we had two significant hassles of students installing a keystroke recorder on a 
computer and ascertaining passwords. These keystroke recorders easily get under protection 
software such as foolproof. Consequently, I never use the master First Class password on 
campus. Several of us use our sub-admin accounts frequently on campus, but have never yet been 
snagged by a keystroke recorder. However, I have been faithful to this advice about never using 
the master admin code on campus and at least psychologically feel more secure about our system.

Avoiding linkage to a file server
At Nobles, we experimented initially with a file server folder that could be accessed from 
NoblesNet. We hit the Templeton effect occasionally of the file server going down which of 
course caused the error message on the NoblesNet server that waited for you to push return to 
continue. With enough other management headaches, we decided the upside was not worth it. 
The Templeton effect, by the way, was derived from John Templeton, former director of 
admissions at St. Mark’s and is really the computer version of the “law of unintended 
consequences.” Each time you do something particularly technically clever, you frequently cause 
negative consequences that make the user wish you had not been so clever!

Creating Accounts via Batch Admin
This is a one line command that you send as a note to “batch admin” that creates an account and 
puts the new user into designated privilege groups. The typical line is

add telecom acc999 Tim "" "Duncan-new" "" password "" "" "" 2 "N License" newstudents

but the real power gets achieved via a spreadsheet
A B C D E F G

1
2

add telecom ng98001 Mary "Lee **2004" av3 2004 "" "" 2 "temp" newstudents398
add telecom ng98208 Amelia "Ali **2003" bt5 2003 "" "" 2 "temp" newstudents398

Creating Fake Accounts for multiple recipients
This is a trick that we have used repeatedly. If someone writes to admissions@chapin.edu, we 
want several people to get the e-mail. We create a fake account with no first name and last name 
of admissions. We give this fake user auto-forwarding ability and then have any mail sent to this 
account automatically forwarded to several people in the admissions office.

Creating our own Forms for N License and Internet Upgrades
At Chapin, we have designed several “built-in” forms that are part of the distribution disks for 
both Mac and PC users. This is fairly time-consuming and fairly technical, but the payoff can be 
significant.

Faculty-Only Conferences for Cut Slips, Work Orders, Academic Warnings, Field Trips
At Chapin, we have a private conference called Faculty Only that students do not see. Within 
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this conference are numerous conferences for adult eyes only. One conference is used for sending 
cut slips on a daily basis, another is used for sending work orders that the maintenance dept 
processes, another is used for issuing academic warnings or posting info on field trips.

Fake “Info” accounts for easily accessible info in the resumes
At Chapin, we have about 15 fake accounts with names like Info CompDept, Info 
CompPurchasing, Info Calendar, Info StudentsAdvisors and Info Phones. We use the RESUME 
of these fake account for information, since any sub-admin can easily edit or copy/paste info into 
the RESUME. This allows almost everyone to access info quickly by looking at the resume of 
one of these fake people.

Insight on who can edit text in a conference
It took us a while to realize that even admins cannot automatically edit any text in a conference; 
in order to edit text, you need to be the controller of that conference.

Internet E-mail Shortcuts for First Class and the Gateway
We have popularized the trick when e-mail arrives in via the gateway, it will get to the person if 
it has a unique name. Therefore, if there is only one Pierce at Chapin, the address can be 
pierce@chapin.edu; for some faculty members with hyphenated names or dual names (e.g. Sandy 
Theunick or Sandra Theunick) we use the trick of putting in a mail alias into the user ID form. 
This can cause problems if the person has previously subscribed to a listserv. To solve that 
problem, we now put into the mail alias something that looks like Steve_Bergen-
fac,webmaster,Students_All. This has the advantage of making all outgoing mail come from the 
proper addressee while directing generic mail (e.g. webmaster) or spam (e.g. students_all) to the 
right person.

Keeping Schedules in the resumes
We have a schedule template that contains the 9 period for the 5 days of the week. We post and 
distribute this template frequently and then get students and faculty members to maintain their 
schedules within their resumes which also contain phones, advisor name, etc.

ListServ Trick#1: Creating a Fake Account and wiring to conference
This is one of two ways that we have dealt with the institutional desire of having a listserv be 
public. We subscribe through a fake account and then create a conference with the same name as 
the account which is subsequently deleted. E-mail via the listserv comes in to that person and 
goes to the conference.
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ListServ Trick#2: Making an Alias of a folder within someone’s mailbox
This is the other way. We have had certain users subscribe to a listserv and then put files from 
the listserv into a designated folder within their mailbox. We then make an alias of that folder and 
put it within a public conference.

Mailing Lists labeled with (ML) and associated netiquette
Every mailing list is labeled with a suffix of (ML) so that it is very easy to recognize. You can 
just type (ML) and get a master list of lists. No student is allowed to use a mailing list. Each time 
it happens, the student gets his/her account frozen and needs to see a computer teacher before 
regaining access. The system follows the guidelines of KIS (keep it simple) and has worked very 
well.

Moderating Conferences by Two People
The standard specification has become that for each general interest conference, the founder must 
be joined by a faculty member or student staff member in maintaining the quality of the 
conference. We set our conference notes to auto-expire after 66 files and do not allow moderators 
to create sub-folders. All notes in conferences require a moderator to approve them before being 
read.

Parent Mailing Lists and Our Parent System re E-Mail
We create a “mailing list” for the parents of each of the 500 students. For example, if Larry Bird 
had his two older children (Connor and Mariah), there would be a mailing list called PAR02  
BIRDC and PAR05 BIRDM that would contain the e-mail addresses of the Bird parents. Using 
these 500 mailing lists, we then have summary lists for parents of each grade and all parents. We 
tell faculty colleagues to use BCC (blind carbon copy) and to be discrete! 

Posting Sounds for French/Spanish Exercises
Modern language teachers have occasionally used GatorNet to post sounds that students would 
then be assigned to play and transcribe. First Class supports recorded sounds.

Privilege Groups for Temporary, N License, G license, Student Staff
At Chapin, we have a plethora of privilege groups for special cases. Temporary licensed students 
have 25 minutes of daily time and no chatting. The specs for N license include 144 minutes, view 
history, chatting on line and resume. Generous students who work for the computer dept get 288 
minutes per day plus the ability to send attached files. Student Staff members get the ability to 
view and in some cases edit the forms re password confusion and/or privilege groups.

Private Conference for Hiring Feedback
At Chapin, we have a private conference called Interview Feedback on the desktop of the 
headmaster and several other key administrators. Each time someone is interviewed for a job at 
Chapin, the faculty member is asked to write a paragraph to Interview Feedback. 

Private Conferences that Act as Portfolios
At Chapin, each ninth grader has a private conference that her/his teachers can mail to; the 
student and her/his teachers have access privileges, so that this conference serves as a portfolio!
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Typing Scores using Subject Line
At Chapin, there is a conference that we use for keeping track of students’ typing efforts. 
Students send a GatorNet note to that conference, with nothing in the body of the note and their 
typing score or practice time in the subject. The folder is then easily sorted by name or subject.

Web Pages and Use for Homework
At Chapin, we have a privilege group called Faculty Public on the Web; those teachers who want 
to “publish on the web” get tagged with this privilege group. Then via a public page on 
gatornet.chapin.edu, students or parents can see the homework of certain teachers. Under the 
FILE menu, there is a feature under OPEN called HOME PAGE. By creating a document there 
called INDEX.HTML and using nothing more than <p> you have a web page for homework 
posting!

 Advanced First-Class Tricks
Accessing the settings file When you buy First Class, there is a special application program 
that is capable of loading and modifying a settings file. What is a settings file? Well, when you 
connect via network, modem or TCP, you have loaded a settings file; this file contains the icons 
and sounds you encounter when using that First Class system.

Graphic As you copy and paste a PICT graphic into this settings file, either the name of the file 
or its resource number is critical. If you want the file to be the “SPLASH SCREEN,” then it 
needs a resource ID of 1000. If you want a background for a conference (e.g. Celtics), then its 
name needs to begin with cuc and be followed by the conference name (e.g. cucCeltics).

Icons can be made with an icon-design program or with res-edit on the Mac. Each icon also has a 
resource number. The manual lists the numbers of commonly used icons. Unless you are seeking 
to replace commonly used First Class icons, the acceptable range is 28000 to 29000. Icons are 
generally 32 pixels by 32 pixels in size, although First Class support icons of any shape or size.

Sounds can also be used to customize your settings file. As with graphics, the interface is to 
Copy and then Paste each sound into your settings file, subsequently assigning the key number 
which identifies function, e.g. 137 for Logoff, or 136 for Search Completed. To assign a sound to 
a conference when it opens, the name must match that of the conference, e.g. Celtics.

Support Having a company such as www.piping.com to lean on is invaluable! 

This 12 page excerpt (pages 24-35) comes from 
Chapter 2 of The Summercore Primer
Written by Steve Bergen and Lynne Schalman 
e-mail: summercore@chapin.edu
www.summercore.com
The Original Teaching Company, PO Box E, Lexington MA 02420
Steve Bergen, CIO, The Chapin School (bergen@chapin.edu)
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Now that books are being 
distributed electronically, the issues 
of honesty 
(www.summercore.com/honesty) 
arise, similar to the MP3 debate. 
Owners of the Summercore Primer, 
the PDF files, or the CD are allowed 
to print only one copy of each 
chapter. Please do not post the PDF 
files on-line or e-mail to others. 
Please reprint or distribute in 
quantity with permission only. 
Thank you!


